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How To: Create a C++ Program Using Microsoft Visual C++ Express 2012

Handout Author: A. Ford Tyson

Important Note: the instructions in this handout provide exactly what you need to do to set up a project which will comply to the current
ISO/ANSI Standard for C++. You must follow these directions to avoid losing points on your assignments for turning in non-standard
program files.

Start by running the Microsoft Visual C++ Express Edition 2012 IDE. You should find this program in your Windows Start menu. When
you first start the program, you will see the Start Page. The Start Page has several components, and may look different from the one
shown here depending on what options are chosen, but it will look generally like this:

m Start Page - Microsoft Visual Studio Express 2012 for Windows Desktop Quick Laur
FILE EDIT VIEW DEBUG TEAM TOOLS TEST WINDOW  HELP
Bal ~ P Attach.. - A
Start Page & X ~ Solution Explorer =
“ &
GET STARTED
EXD [ Welcome
(il iy Nachiar
Windows Desktop
.:M What's New in Windows Desktop Development
What's new ual CF
What's new ual Basic
What's new ual C++
What's new ndows Presentation Foundation (WPF)
What's new in Windows Forms
ﬂ Getting started with Windows Desktop Applications
Rert o Learn te build Win32 / Visual C++ applications
RELEIE Learn to build WPF applications
Learn to build Windows Forms applications
Discover extensions, add-eons and samples
ru Learning Resources
i) AP reference for Win32
API reference for WPF applications
APT reference for Windows Forms applications
Visual Studic troublesheooting and suppert
Visual Studio videos on Channel 9 =
DU £ e e R R e R R S R e e e e e - [

Show output from: - a

You will enter your C++ program into a .cpp file. Microsoft Visual C++ Express organizes your program file plus additional files that are
needed to work with the program into a project. Recent projects that you have worked on will appear on your Start Page, as well as
options to open an existing project or create a new project.

Creating a New Project

Pull down the File menu and select New Project...

You will now see a window that looks like this:
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Eﬂ:jeﬂ |ii

b Recent Sortby: Default - Search Installed Templates (Ctri<E] 2 =
4 Installed 4 ;
h Win32 Console Application Visual C++ Type: Visual C++
4 Templates “ A project for creating a Win32 console
P Visual Basic Win32 Project Visual C++ application
B Visual C#
4 Visual C++
CLR
General
Test
Win32
Visual Studio Solutions
Samples
b Online
Mame: ConsoleApplicationl
Location: C\Users\Aftyson\Documents\01_werkingOn', - | Browse...
Solution name: ConsoleApplicationl Create directory for solution

[] Add to source control

OK | | Cancel

In this window,

« click on Win32 under Templates

« click on Win32 Console Application in the adjacent window frame

type firstProgram as the name (replacing the default ConsoleApplicationl)

« use the Browse button to select a location for your program folder

check the box next to Create directory for solution (or leave it checked if it is already)
« click OK

Microsoft Visual C++ Express will now create a new project for you in a new directory according to your choices.

You will see a new window:

Win32 Application Wizard - ConsclefApplicationl

D Welcome to the Win32 Application Wizard

These are the current project settings:

Owerview
» Console application

Application Settings
Click Finish from any window to accept the current settings.

After you create the project, see the project's readme. txt file for information about the
project features and files that are generated.

Next> |[ Finish |[  Cancel |

Click on Next.

In the next window,
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« select (check ) Console Application under Application Type
« deselect (uncheck) Precompiled header under Additional options
« select (check) Empty Project under Additional options

and you should see this:

Win32 Application Wizard - firstProgram

=y Application Settings
| C:\_

Owverview Application type: Add common header files for:
() Windows application ||
(®) Console application Il me
oo
() Static library

Application Settings

Additional options:
Empty project
E
|

Security Development Lifecyde {SDL)
checks

Frh ] [ Gonce

Now click Finish. You now have a project, but it does not include a .cpp file (the "source code™) as of yet.

Add the Source File

We need to add the .cpp source file for our program now.

Under the Project menu, choose Add New Item. You will see a new window. In this window:
* under Visual C++ click on Code
« in the adjacent window click C++ File (.cpp)

« type helloworld.cpp as the Name (replacing Source.cpp)

You window will look like this:
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Add New Item - firstProgram

EiEsa]

Visual C++

Visual C++

Visual C++

4 Installed Sortby: Default
Visual C f <

BatuT RS D G+ File (.cpp)
ur
o h“‘ Header File (.h)
Web eader File (.
Test - o
Utilty s omponent Class
Property Sheets

b Online

Name: helloworld.cpp

Location: C\Users\Aftyson\Documents\01_werkingOn\firstProgram\\firstProgram

- Browse... |

Search Installed Templates (Ctrl+E) P~

Type: Visual C++

Creates a file containing C++ source code

Add || cancal |

Next, after you click on Add, you will see a new window display allowing you to type your program into the upper left window pane.

Type the program in as follows:

w firstProgram - Microsoft Visual Studio Express 2012 for Windows Desktop
FLE EDIT VIEW PROJECT BUILD DEBUG TEAM TOOLS TEST WINDOW HELP
o-0 BEM 9-

P Local Windows Debugger = Debug - Win32

A.mE uB0 .

Quick Launch (Ctrl+ Q) p = B X

+ Solution Explorer - v ix

(Global Scope)
#include <iostreams
using namespace std;
-iint main()

cout << "hello world!" << endl;

return 8;
1}
W% -
Qutput =
Show output from: 2 b

Error List Qutput

Ready
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Building and Running the Program

Under the Build menu, select Build Solution. This option will pre-process and compile your program and also link it with the C++

language libraries that are needed to run it. If the program was typed in incorrectly, you may see compiler errors listed in the error
window. If there are any, fix them and then re-build.

When the build was successful, you will see this:

N firstProgram - Microsoft Visual Studio Express 2012 for Windows Desktop

Quick Launch (Ctrl+Q) p - 8 x
FLE EDT VEW PROKCT BULD DEBUG TEAM TOOLS TEST WINDOW HELP

0-0 BENS - b Local Windows Debugger - Debug - Win32 - B LI I

helloworld.cpp +# X

~ Solution Explorer s v X
{6lobal Scope) . - A e-2dB o /:
#include <iostreamy + "
i ¥ Search Solution Explore (Ctrl+) p-
using namespace std; .
Eint main() m Solution firstProgram’ (1 project]
4 & firstProgram
co:trﬂa‘hellu world!" << endl; b &2 Bxtemal Dependencies
) i Bl Header Files
B Resource Files
4 4] Source Files
b+ helloworld.cop
Properties cnmmmmmnmmmnm e ¥ B X
L4
0% -
Output v ix
Show output from:  Build v &
1p--eee- Build started: Project: firstProgram, Configuration: Debug Win32 ------ P
1> helloworld.cpp
1> firstProgram.vcxproj -3 C:\Users\Aftyson\Documents\@1_workingOn\firstProgram\Debug\firstProgram.exe
=== = Build: 1 succeeded, @ failed, @ up-to-date, @ skipped ==========
v
Error List Output
Build succeeded Lnl Coll Chl NS

Now we can run the program!

To run it, go under the Debug menu and choose Start without Debugging. This will run the program normally, that is, not in
"debugging" mode (we will learn about debugging later on).

You will see this output window for the run, which is called the console window:
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hello world! .
Press any key to continue .

To quit the program run, click on the X in the upper right corner of the console window.

DISABLE LANGUAGE EXTENSIONS

Page 6 of 8

The Visual C++ system includes a number of features which are not available in standard C++. For programs to be most portable, these
extensions should always be disabled. Also remember that your program grade will be decremented if non-standard language elements are
found. We will discuss much more about this in class. To help prevent non-standard elements from compiling in your code, you should
perform the following steps for every project you work on. Keep in mind that your most important references for what is currently
standard are in-class discussions and your required course C++ textbook.

Start with your firstProgram project space open. Go under the Project menu and select firstProgram Properties. Click on the triangle
next to Configuration Properties, then click on the triangle next to C/C++. Underneath C/C++, click on Language. Your window
should now look like this:

firstProgram Property Pages

=

Configuration:

Active(Debug)

* | Platform: |Active(Win32)

‘| | Configuration Manager... |

4 Common Properties

Framework and References

4 Configuration Properties
General
Debugging
YWC++ Directories
a C/C++
General
Optimization
Preprocessor
Code Generation
Language

Precompiled Headers

Cutput Files
Browse Information
Advanced
All Options
Command Line

. Linker

= Manifest Tool

> XML Document Generator

- Browse Information
Build Events

i Custom Build Step

i Code Analysis

e olf [T

i

Disable Language Extensions

Treat WChar_t As Built in Type

Force Conformance in For Loop Scope
Enable Run-Time Type Information
Open MP Support

Disable Language Extensions
Suppresses or enables language extensions,

Mo
Yes (fZcwchar_t)
Yes ((Zo:forScope)

(/Za)

0K

| [ Cancel
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Next, go to the right windowpane where you see Disable Language Extensions. Click on the area where you see No, pull down the

triangle to the right side of this area, and change the option to Yes. You will now see this displayed:

firstProgram Property Pages

7

i

Configuration: |Active(Debug)

~| Platform: | Active(Win32)

4 Common Properties
Framework and References
4 Configuration Properties
General
Debugging
WC++ Directories
a4 C/C++
General
Optimization
Preprocessor
Code Generation
Language
Precompiled Headers
COutput Files
Browse Information
Advanced
All Options
Command Line
> Linker
= Manifest Tool
» XML Document Generator
+ Browse Information
» Build Events
= Custom Build Step
» Code Analysis

i T T b

Disable Language Extensicns

Treat WChar_t As Built in Type

Force Conformance in For Loop Scope
Enable Run-Time Type Information
Open MP Support

Disable Language Extensions
Suppresses or enables language extensions,

Yes (/Za)
Yes (fZcwchar_t)
es ((Zc:forScope)

(/Za)

'l | Configuration Manager... |

|| cancel || Apply

The /Za compiler option, when turned on, emits an error for language contructs that are not compatible with either ANSI C or ANSI C++.

Finally, click on Apply first, and t

hen click on Ok.

You can quit the MS Visual program by going under the File menu and choosing Exit. Be sure to Save your program and project first,

any time they have been modified.

YOUR PROJECT FILES

Microsoft Visual C++ Express automatically creates folders and files to carry out the operations required to work on your program. For
example, if you look at two of the folders and the major files for the project we just created, you would see something like this:
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File Edit View Tools Help

» %vmﬁu

| Debug
firstProgram
[ firstProgram.sdf

faC firstProgram.sin

firstProgr...
File folder

AV Date mod.. . |
\

File Edit View Tools Help

» jEE L m |:@
Name ’
. Debug
(%] firstProgram.vexproj

& firstProgram.vexproj filters
*+ helloworld.cpp

4 tems
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The ONLY file you need to turn to us for grading is your .cpp file. Do not turn in any of the other files for project

grading.

SUMMARY

You have created a project using Microsoft Visual C++ Express, then entered and run a C++ program successfully. After you have

completed this process once or twice, it will be easy and you'll be able to set up a new project very quickly.
You should use these same instructions to create every program you work on in this course and turn in for grading.

NOTE ON RE-OPENING A PROJECT TO WORK ON IT AT ANOTHER TIME

If you want to work on the program you just created at another time in the future, start by double-clicking on the .sIn file. That is the
quickest and easiest way to get back to the point where you can work on your program. You do not need to start MS Visual C++ prior to
clicking on the .sIn file, as MS Visual C++ should start automatically as soon as you load the .sIn. Think of .sIn as standing for the word

"solution."

Last Update: August 20, 2013 A. Ford Tyson
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